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Modelling 

 

Box modelling 
A simple primitive such as a cone, cube or square is edited to create the desired form. Reference 
images may be placed next to the primitive and the modeller may have multiple views, copying the 
reference, adjusting and editing the form as they progress. The primitive may be subdivided. 
 
 
Software: Autodesk 3DS Max 2015 or above 
 
 

  
1. Load 3DS Max and start a new scene. Maximise the perspective viewport by clicking on the 

plus button of the window (the viewport selected will outline in yellow). Dual screens and 
multiple viewports help the modelling process. On the right-hand panel select Standard 
primitive > Box. Draw a box 10, 10, 10 in length, width and height. Create ten segments for 
length, width and height. 
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2. Right click on the object and select Convert to > Convert to editable poly.  
 
 

 
3. Select the modify tab, next to the sun icon on the right-hand panel. The panel states 

‘editable poly’. Press the plus icon on this and select the polygon icon in red below. You can 
select different parts or all of the object using the five red symbols: vertex, triangle, 
boundary, polygon and element.  
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4. A new set of windows appears in the modify tab. Select Extrude and click on various faces. 

You may use the mouse to extrude the selected element. Clicking the extrude settings lets 
you specify a specific unit to which the polygon will be extruded. Experiment with these 
settings, dragging the extrude feature within the square to create a void. 
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5. Add reference images. Select the Front viewport and select Plane in the primitive area. Make 

the image plane the same size as your reference image to avoid pixelisation. Draw a plane 
behind the object. Select the Material editor (M on keyboard). Click on a blank sphere. Click 
Modes > Compact material editor for this exercise. Select Get material and select Maps > 
Bitmap. Load the image you wish to reference. Ensure ‘use real world scale’ is NOT selected. 
Press Assign material, or drag the material and drop it on the image plane. Add additional 
references on different viewport areas to increase the ability to box model. 
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Contour modelling 
This is the creation of edges of the form wished to be drawn; the edges are then infilled. This allows 
greater control than subdividing a primitive. In this case actual contours can be used to create a 
surface. 
 
Software: Autodesk 3DS Max 2015 or above 
 

  
1. Load 3DS Max and Import the 5m contours DWG file. Do not adjust the default settings in 

this case. 
 

 
2. Select all of the contours/objects and from the rollout on the right select Create, then 

Geometry and choose Compound objects from the rollout menu below. 
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3. Select the Terrain tab in the compound object selection to create a surface between lines 

(like sandbox tools in Sketchup).  
 

 
4. Select the Colour by elevation tab and maximise. You can specify contour interval colours or 

set to default.  
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5. You can also apply a material texture of a map or correlated satellite photo to the contour 

area. Once these choices are complete, render the scene (teapot icon) through the normal 
default scanline to view the contour model with gradated colours. 
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Perspective match tool 
 
The Perspective match tool in 3DS Max is similar to the Trimble Sketchup Match photo technique 
and Trimble Vision for accurate photo stitching and verified views (Chapter 3). The tool matches a 
background to a 3D model and coordinate plane. 
 
Software: Autodesk 3DS Max 2015 or above 
 

  
1. Load 3DS Max and maximise the Perspective viewport. Drag an image reference to the 

picture plane. 3DS Max asks whether the image is a background or environment map.  
 
2. The reference image aspect ratio (width and length of image) needs to match the camera 

aspect ratio. Thus, if an image is 1028 px wide, the camera needs the same setting. 
 

 
3. Click the Utilities icon on the right-hand side panel, and select Perspective match. 
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4. Click Show vanishing lines to display the vanishing points. Adjust the red and green for 

vanishing points and blue lines for the angle of model to background photograph. Adjust the 
field of view, dolly and hand tool to further adjust the perspective match. 
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NURBS surfaces 
NURBS (non-uniform rational basis spline) surfaces are edited by manipulating control points or 
control polygons. Additional points may be added for complexity. 
 
Software: Autodesk 3DS Max 2015 or above 
 

  
1. Open a new file in 3DS Max and select NURBS surfaces in the Create tab on the right-hand 

side. Select CV surf, and enter the length 150 and width 150. Enter the CVs length and width 
as 10.  

 

 
2. Click the Modify tab and select Surface CV. Select Single point and the Select and move tool 

(S on keyboard). Manipulate each point to create a curved topo surface. You may add a 
texture map or photograph using the Material editor (M on keyboard) once the surface is to 
your liking. 
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3. Open a new file in 3DS Max and select Shapes in the Create tab and select NURBS curves. 
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4. Select CV curve and map a curved line. Select Modify and maximise the NURBS curve area; 

select Curve and then select Create surfaces and Extrude. Enter a unit of your choice to 
extrude the line, selecting the axis in which this is to extrude, X, Y or Z. 

 

Additional links 
 
https://knowledge.autodesk.com/support/3ds-max/learn-
explore/caas/CloudHelp/cloudhelp/2016/ENU/3DSMax/files/GUID-FD120DDE-E8BE-4DB9-A2CA-
62069059B4FF-htm.html 
 
http://help.autodesk.com/view/3DSMAX/2016/ENU/?guid=GUID-FD120DDE-E8BE-4DB9-A2CA-
62069059B4FF 
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Sculpting 
This involves direct manipulation of surfaces – carving, pulling, pushing – and is a newer modelling 
mode, useful for imaginative speculation of terrains and intuitive and tactile creation of meshes 
from scratch. Additional features allow the direct texture painting on the surface mesh, allowing 
quicker modelling processes to be realised. 
 
Software: Autodesk Mudbox 2016 or above 
 
Interoperability note: you may use the FBX file format to import references. You may also use a 2D 
image as a reference (Window tab > Image browser). You can export your model to Photoshop as a 
still PSD, Softimage or as a scene in 3DS Max. 
 
(Navigate keyboard shortcuts: Rotate the camera = Alt + left mouse; Track = alt + left mouse; focus 
on location = F; frame all = A). 
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1. A fictional city area has been generated through scripts and extruding meshes in 3DS Max. 
Open Mudbox and go to File > Import and select the sculpting FBX file.  

 

 
 

 
 

 
2. This mesh can be sculpted using the pre-set tools in Mudbox. Select Sculpt and navigate to 

an area and push and pull the mesh. Use the Grab feature to create fictional building 
heights. The properties window (Display > Properties > Sculpt) shows the Sculpt tool settings. 
A 3D stamp brush can be used either from the default of through add-in brushes. To create 
the building heights here the Stamp tool was turned off. Adjust the falloff curves further 
down the properties window to determine the cross-section shape of the tool. You may wish 
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to sculpt and paint with a Wacom tablet, and the pen pressure settings can assist in the 
model capability here. 
 

 
3. You may mask the tip of the sculpting tool by using a stamp. Select Randomise and adjust 

the horizontal and vertical jitter, scale and opacity. Select the spacing tool to spread the 
stamp image to allow repeat patterns with no overlap. For straight sculpting, select Steady 
curve in the properties window. The stamp works to the distance of the cursor, not the 
movement of it. 
 

 
4. Select the Render tab and select Save screen image once you have a view you are 

comfortable with. You may also record a movie in a variety of sizes and formats and navigate 
around the model. 

 
 

Additional links 
 
Mudbox guide: 
http://docs.autodesk.com/MBXPRO/2016/ENU/?_ga=1.57982312.335103882.1460620998#!/url=./fi
les/mePortal.htm 
 
3D brushes: www.textures.com/browse/3d-brushes/114539 
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Dynamo 
 
Scripting: also known as procedural modelling, such as L-systems, fractals and generative modelling. 
This procedure involves the instigation of rule- or value-based parameters on a form to control it 
(Burry, 2011). For example, the application Speed Tree allows specification of vegetation, growth 
and wind simulation. Dynamo has a similar visual programming interface like Grasshopper. 
 
Software: Dynamo 0.9.2 or above 
 
Plug-in: Elk – www.hksinc.com/hksline/2015/10/26/elk-mapping-plugin 
 
This Dynamo tutorial is transcribed from instructions of use for the Elk plug-in, developed by 
Timothy Logan from HKS: www.hksinc.com/hksline/2015/10/26/elk-mapping-plugin. The short 
tutorials follows Timothy Logan’s research and instruction: www.hksinc.com/hksline/author/tlogan. 
 
Interoperability note: load Dynamo through Revit (Add-ons tab) if you cannot see the 3D geometric 
preview. 
 
Additional links: 
 
Dynamo Primer: http://dynamoprimer.com 
 
GIS into Dynamo then to REVIT: https://knowledge.autodesk.com/support/revit-products/learn-
explore/caas/screencast/Main/Details/5040f6cc-2cfb-4513-9a59-30fd78edeca7.html 
 
GITHub: https://github.com/DynamoDS/Dynamo 
 

   
 

1. Go to Open Street Map > www.openstreetmap.org/#map=15/51.1363/4.5809. Locate an 
area and click the export button in the top right. The map interface may not be able to 
export large terrain sets, and provides an error message. Use the mirror sites directed or 
choose a smaller area. The files are provided as OSM types. 
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2. Load Dynamo and in the top toolbar click Packages, search for Elk and install it. Create a new 

file. 
 

   
3. Right-click and search or use the top left search toolbar and type ‘file path’. This determines 

the location of the Open Street Map data. 
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4. Select OSM location in the Elk tool in the left-hand panel. Drag to the visual coding window. 
Connect the file path to the OSM location file path. Right-click and enter ‘watch’; add the 
command and connect the OSM Location loc node. This provides a latitude and longitude of 
the OSM data set. 

 

 
5. Drag the OSM data node to the graph view. Connect the OSM node to the OSM data 

panel/OSM node. Connect the xml node to the file node in the OSM data window. Drag the 
OSM features to the graph view. This allows inspection of the various data strings. 

 

 
6. Right-click and create a code block. This will allow us to display individual data strings on the 

map. Type ‘building’; this will display building footprints of the data. Connect the code block 
to feature type. 
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7. Add the sub-features window to the graph viewer. Connect the code block node to the OSM 

sub-features, feature node. Create a code block ‘{ }’ and connect it to OSM, sub-features (for 
full display of all the map strings). 

 

 
8. Connect the OSM sub-features, selected node to OSM data, subtypes node. Create a new 

geometry window, PolyCurve by Points. Connect the OSM data points node to the points 
node of the geometry. Right-click, enter Boolean, and ‘true’ and connect last to first node of 
the PolyCurve by Points window. 
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9. Ensure the geometry is displaying. Dynamo standalone may have issues, if this is the case, 

load Dynamo through the Add-ins ribbon in Revit. Finally, tidy the graph and windows as 
displayed. Add another OSM data window and connect to the code block feature type and 
subtypes nodes. Create Polygon by Points and connect to the OSM data window. 
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Elk for Topography 
 
Elk may also process HGT or GeoTIFF satellite or UAV data. 
 
This tutorial uses SRTM data. The Shuttle Radar Topography Mission (SRTM) obtained elevation data 
on a near-global scale to generate the most complete high-resolution digital topographic database of 
earth. SRTM consisted of a specially modified radar system that flew onboard the Space Shuttle 
Endeavour during an 11-day mission in February 2000. SRTM is an international project spearheaded 
by the National Geospatial-Intelligence Agency (NGA) and the National Aeronautics and Space 
Administration (NASA). These data are for educational purposes only. 
 

  
1. Expand the Elk interface in Dynamo. Create a file path (search) and specify the map.som file 

supplied for this tutorial. Create an OSM location window and drag the file path node. 
Create a watch window and connect to the OSM Location, loc node. Drag a CreateTopo 
operator from the left panel and connect the loc node in OSM Location to the loc node in 
CreateTopo. 

 

 
2. Drag a Topo deconstruct location operator to the graph window. Connect the OSM Location, 

loc node to the location node of the new operator. This assists is determining the extent and 
geographical position of the data set. Create a file path, select the N38W112.hgt file and 
connect to the file path of the CreateTopo window. Connect the curves node to a new code 
block with ‘data’ as its parameter.  
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3. Go to settings and render precision to increase the display values.  
 

 
4. Go to file and export as an STL to prepare the file for 3D printing in Meshmixer, or return to 

Revit to load the data-driven data into the BIM environment. 
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Other methods of modelling 
 
Software: Autodesk Recap, Remake (formerly Memento) 2016 
 
Photogrammetry: this is the deriving of 3D assets from 2D images to create 3D meshes or 
photographic point clouds. Distances are measured between the camera position and the object; 
colour spectrum is also calculated to create a 3D mesh. A number of free software programs allow 
this creation using cameras, phones and tablets as well as drones. For complex calculations, GIS 
preparation is required involving ortho-rectification, feature extraction and height calculations. ESRI 
City Engine and ArcGIS Pro and 3D GIS Stream Services, among other software, are dramatically 
decreasing the production time and accessibility of data. 
. 
Point clouds: Laser scanning (LiDAR) is the laser scanning of real-world places or objects which form 
bases in which to model. Received as a point cloud, the data require rasterising, or can be 
manipulated or repaired – see Chapter 1 exercises for LiDAR processing to a raster surface. 
 
Interoperability note: to add a point cloud in 3DS Max go to the Create panel, select Geometry 
rollout > Point cloud objects > Object type rollout > PointCloud. 
  

  
1. Load a series of photos in Autodesk Recap or create a scan project. Recap has more 

capability and precision than 123D Catch (Chapter 1, Tea House). 
 
2. Press the Settings button to add a coordinate system, unit of measurement and adjust the 

field of view. 
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3. The upload works in the Cloud and is processed. Once complete you can view the model and 

change the texture, with a shader, wireframe or clay display.  
 

 

 
4. Load Autodesk Remake and the newly created model will be available in the Cloud. You can 

analyse the quality of the mesh and repair, sculpt, clip or smooth the mesh through the 
editing features to the left-hand panel. You can also prepare the mesh for 3D printing (see 
Chapter 5). These features are similar to Meshmixer, though Remake can handle much 
larger polygon counts and meshes. 

https://www.routledge.com/Strategies-for-Landscape-Representation-Digital-and-Analogue-Techniques/Cureton/p/book/9781138940987


 

Strategies for Landscape Representation: Digital and analogue techniques, Routledge. ©2017 Paul 
Cureton. 
Material to be used for educational purposes and with book companion. 

 

 
5. Once editing is complete, use the Export button to save the file, either for 3D printing as OBJ 

type, or as an FBX file for use in Revit, 3DS Max, Stingray, Infraworks or Civil 3D, to name a 
few. 
 

 
Interoperability note: Recap can be used to process UAS stitching ortho-photos and create meshes. 
Once this work is processed in the cloud, Autodesk Remake can allow the editing of meshes, polygon 
reduction, texture editing and export of the 3D model. The model can then be used in AutoCAD, 
Infraworks and Civil 3D. 
 

Additional links 
Recap workflow: www.youtube.com/watch?v=oA6b5kG8YvI 
 
 
BIM models: building information models can be used within the modelling process, from 

manufacturers’ products, to energy performance analysis, mass models or other forms. Stereo pair 

photography can be used to create 3D building models that have high degrees of accuracy and can 

be brought into the workflow (Institute, 2016). The BIM process could be from inception, or in this 

case if specific products and building specifications are needed, can be added to the project.  
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1. Visit the National BIM Library (www.nationalbimlibrary.com). Download a retaining wall and 

open this in Revit. The BIM object has manufacturer details, energy performance and IFC 

standards. IFC essentially governs the shareability and interoperability of the object. The 

BIM object is a mixture of geometry and dimensions with product and technical data sheets. 

BIM objects can be incorporated into Revit schedules, bills of quantities and phases. 
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2. Select the object and select Properties. Select Viewer in the Architecture tab and select 

Properties if it is not displaying. Press the Edit button to view the properties. Additional BIM 

objects can be loaded directly into the model using the NBS plug-in. 
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Revit to Stingray 
BIM models and components can be visualised and animated in Autodesk’s Stingray game engine, 

allow unprecedented presentation and interaction in BIM landscape works. BIM models based on 

National Building Specifications can be added to Revit project phases and schedules. 

Alternatively, through photogrammetry algorithms in Autodesk Recap, photos can be converted to 

meshes, edited in Remake, saved as FBX file types then added to Stingray. 

Software: Autodesk 3DS Max, Revit 2016, Recap, Remake, Autodesk Stingray 

 

Interoperability note: texture import may not assign textures and may require manual assignment; 

however, this issue is being resolved at the time of writing for Revit models. 

 

  
1. Load Revit or Remake and save your model as an FBX file type to allow Stingray to work with 

it. 
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2. Create a new empty project with a sky dome and environment. Save a local copy. Select the 

Asset viewer and Import. Import the FBX file. Adjust any parameters here if material maps 

are not required. Lights and camera setting from 3DS Max can be recognised. 

 

 

3. Place the asset in the environment, rotating and scaling as required. Once complete, press 

the Play button and use the keyboard keys w, a, s, d to navigate the space alongside a 

mouse. 

 

Additional links 
Stingray Guidance: http://help.autodesk.com/view/Stingray/ENU 
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